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Cautions for Use
Please be sure to read and follow the instructions below for safety use.
Intended use: L100 is intended for laser marking



The instructions below are intended to prevent personal injury and property damages.
Please read carefully and use the machine properly.
If you do not follow these instructions, injury or property damage may occur.
If you do not follow these instructions, users may be seriously injured.

 Cautions related to power
Do not use damaged cord or loosened outlet.
 It may cause electric shock or fire.
Do not pull a plug by the cord. Do not touch a
power plug with wet hands.
If smoke comes out from the product during
use, turn off the product immediately and
call the sales agency or our service center.

Do not put multiple power plugs into
one inlet simultaneously. It may cause
fire due to overheated inlet.
When the product is not in use for a
long term, pull out the power plug.
Plug-in the provided power cable only
to the grounded outlet (power mains).
If the outlet (power mains) is not
ground-wired, set the grounding
separately.

 Cautions related to use
Do not use this machine in a place with oil,
smoke, humidity, dust or water.
 It may cause electric shock or fire.

Do not put a candle or cigarette butt
on the product. Avoid any heating
apparatus like heater when using this
machine.
 It may cause failure or fire due to
overheating.
Be sure not to be caught or jammed
between the paths of each axis of the
product.

Be sure to place the product body only on a
stable level surface.
When temperature falls below freezing point,
the product may not normally perform. In
this case, please sustain the room
temperature in the place where you use this
product for normal operation. Please make
sure the temperature in the place where you
use the does not fall below the freezing
point.
Do not disassemble or modify the product.
 It may cause fire, electric shock or
failure. Please contact the sales agency
or our service center for Inspection,
calibration and repair.
We will not be held responsible for damage
caused to product by misuse or poor care.
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Do not put water or small metal
materials on the product.
 Due to negligence or vibration of
the product, the materials may fall
and cause injury, fire or failure by
overheating or short circuiting.
 If water gets into the product, it
may cause electric shock or fire.
Be sure to keep out of the reach of
toddlers and children. Their curiosity or
carelessness may cause injury.

Cautions on Laser Products
CAUTIONS
The control and operation of the laser
generator (CLASS 4) in a way other than its
intended purpose may result in the
exposure of dangerous laser radiation.
Be careful that if a body part (e.g., eyes, skin,
etc.) is exposed to such laser radiation, you
could suffer from serious damage.

The front part of the head has a shield (L100:
1,064nm or higher wavelength, 6 or higher
optical density). Do NEVER expose yourself
to laser radiation with the shield cover
removed or open. Make sure that you are not
exposed to the laser even through such
shield. Otherwise, it may result in blindness.

Do not stare at the specular/diffuse
reflection of laser. It may result in blindness.

Make sure that your body part is not in the
operating range. It may result in skin damage
such as burn.

Do not use the product for purposes other
than those intended.
Otherwise, you could be damaged by laser
radiation.

Appoint a laser safety manager and have him
keep monitoring a laser risk and fully
understand safety measures. According to
each country’s laws, the safety measures for
the class-4 laser system are mandatory.

If you wear a pacemaker, do not come near
the product or work area.
It generates electromagnetic waves and can
cause malfunction to the heart rhythm
device.

Do NEVER dismantle or remodel the product
randomly.
Otherwise, you could be exposed to laser
radiation and suffer from eye/skin damage.
In addition, exposure to a high-voltage part
can result in an electric shock.

Make sure that you have a system which
emits the dust and haze which are
generated during operation. The warranty
does not cover the system damage or failure
resulting from corrosive haze.

During product maintenance and control,
make sure that the laser radiation is stopped,
and safety goggles are put on. The eye/skin
exposure to laser radiation can result in
serious damage.

If any defect is found, do not use the
product and contact the Service Center
(+82-70-7011-0905).
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* For safe operations (Laser Class 1 Safety),
Stay alert all the time when using the laser system.*

Laser generator specifications
This product uses laser generator. In accordance with IEC60825-1, JIS C6802 and FDA(CDRH) Part 1040.10,
CLASS 4 was adopted.
- CLASS 4: Approach to laser is very dangerous to the eyes and skin. An emitting laser may cause
fire or explosion.
Type
Class

Wavelength

Fiber
Class 4
20W
30W
1,064nm

Frequency

1-400kHz

Cooling System
Lifespan
CW

Air Cooling (Built-in)
100,000hours
NOT POSSIBLE

Output
(User Choice)

Max. Output

100W

Pulse Width

200ns

Quality of Laser Beam

<1.3M²

In addition, it is available as a guide laser to handle the red laser ‘CLASS 3R’.
- CLASS 3R: The approach to laser within visible spectrum (400-700nm) and 1mW or below is conditionally
permitted. Exposure up to 0.25 second is okay for the eyes. However, laser approach can be
dangerous.
Class
Output
Wavelength

Class 3R
5mW
650nm

Laser Range
If a body part or flammable material comes into the range of laser radiation, it may result in eye/skin
damage or fire. Cover it with a proper shield which has decent reflection and thermal properties considering
the risk of such range.
(The marked distance represents the maximum width. It may differ from actual values.)
89mm

184mm

112mm

LENS

112mm
[Marking Zone]

21.4°

158.4mm
[Laser Range According to the Diagonal of Marking Zone]
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Product parts and installation
1. Parts and Accessories
The L100 provides the following accessories besides the base unit.
Their composition may differ depending on options.
Name

Picture

Quantity

Usage
Power supply
※ Use the power cable connected to the
grounded outlet. Unless the outlet is
grounded, separately ground the machine.

Power Cable

1EA

USB Cable

1EA

PC connection

Program CD

1EA

Design & marking software

User Manual

1EA

Operating manual

Clamp

1SET

Position support

Clamp Bolt (M512mm)

4EA

For holding materials in place.

L-wrench
(4mm)

1EA

Tool for tightening/replacement of bolt.

L-wrench
(2mm)

1EA

Tool for setting the focus pointer.

MagicArt
Program Unlock
USB

1EA

For running the MagicArt program.

Ruler

1EA

Clamp Pin (6Ø)

2EA

For holding a optional clamp in place.

* Optional (Purchased separately)

Honeycomb
Table
Set

Honeycomb
Table

1EA

For holding materials in place when
cutting process.

Honeycomb
Table Tray

1EA

Tary for Honeycomb Table
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Medal
Clamp
Set

Medal Clamp

1EA

For holding a variety of shape of
materials in place.

Pin

6EA

For holding of irregular shaped
material.

1EA

For holding a variety of shape of
materials in place.

Blower

1EA

Dust & smoke discharge
*There may be parts not homologous
with the manual.

Blower Hose
(100Ø)

1EA

Blower connection hose (5M)

Hose clamp
(4inch)

3EA

For connect to blower and hose.

Chuck
Handle

2EA

Rotary clamp-tightening handle

Chuck
Finger
(2mm)

3EA

For holding thin rings when marking
thin ring’s inner/outer diameter

Finger Skin

1SET

For protect chuck fingers.

Finger
Spanner

1EA

Tool for tightening chuck fingers.

Rotary
Clamp

1EA

For holding ring materials in place.

1EA

Other device
Connect to USB Atype port.

Auxiliary
Power
Device

1EA

Auxiliary power device is required
when using the dust collector.

Power cable

2EA

Power supply and connect the
machine.

L type clamp

Blower
Set

Rotary
Clamp
Set

Foot Switch

Auxiliary
Power Device
Set
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2. Specifications
Laser safery classification
Power consumption

Class 1
AC 100~120V/ AC 200~240V

Frequency

50/60Hz

Operating voltage

< 400W

Blower power port

110~220V/2A

Dimensions
Weight

358*550*585 (W*H*D)
45Kg

Max.engraving area

Flat: 112(X)*112(Y)*115(Z)mm / Rotary: 85(A)mm

Minimum line width

0.05mm

Marking speed

3000mm/sec(X,Y) / 18mm/s(Z)

Temperature

15 – 35 C

Humidity

10 - 90 %

Purposes

Metal marking, Ring inner diameter marking, Ring outer diameter
marking,.
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3. Descriptions
(1) Product

A. Moving
Cover
F. Outlet

B. Laser Head
C. Laser-shielding
window

G. USB B Port
H. USB A Port

I. Blower Power Port

D. Circular
Connector
E. Control Panel

J. Power Port

Press [Moving Cover] to open/close the cover automatically.
A

Moving Cover

※ Once the program is connected, the cover is automatically
opened.

A laser irradiation part.
B

Head

C

Laser-shielding Display

Do not stare at the specular/diffuse reflection of laser.
It may result in blindness.

Protects the eyes from laser radiation during laser marking.
※L100: Wavelength to protect: 1064nm/ Optical density: OD6

Connects the power cable of the rotary clamp with the
product and controls the A-axis of clamp at the use of rotary
clamp.

D

Circular Connector

E

Control Panel

F

Outlet

G

USB Btype Port

Connects the USB cable plugged into the cable.

H

USB Atype Port

Connects the other device cable plugged into the cable.

I

Blower Power Port

J

Power Port

Controls the power button and marking machine.
Connects the duct hose to the outlet and removes dust
generated during product processing.

Connects the blower power.<110~220V/2A>
Connects the power adapter and supplies power to the
marking machine.
※ Use the power cable connected to the grounded outlet. Unless
the outlet is grounded, separately ground the machine.
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(2) Buttons

* All buttons but POWER and EMERGENCY SWITCH are inactive until the program is connected.
Connect the program and start the system.
EMERGENCY SWITCH

Emergency stop

POWER

Product power button

VACUUM

Vacuum dust collector power button

MODE

Mode switch
· If the button is pressed short (immediately released): Zheight is preset. Press the button and move the laser focus
to the preset height.

FOCUS

DIRECTION
KEY

DIRECTION
KEY(Z)
FOCUS
POINTER
COVER

· If the button is pressed long (released in one second or
later): Once the button is pressed long (1 second or longer)
after adjusting the laser focus-moving height, the preset
values are saved (linked with the height of program
materials).

Moves the guide laser pointer under the laser
·Flat: Moves X and Y axes
·Rotary: Moves A axis

Moves Z-axis up and down
Turns ON/OFF the guide laser pointer
Opens/closes the front cover

STOP

Stops marking

START

Starts marking when pressed long
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4. Installation
※ Please follow the instruction below in order for use the solution.
※ This program requires windows OS 7 or later.

(1) Installation of Marking Machine
L-100 is a desktop CNC marking system. Marking can’t be done with the product only.
It should be connected to the personal computer, and the program provided should be used together for
marking.

USB Cable

Power Cable  Outlet

Plug the USB cable into the port on the back of the product and computer’s USB port.
Plug the power cable into the outlet.
And switch on the marking machine.
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(2) Driver Installation
1. Go to [Device Manager], And select the [USBLMCV2] using by the mouse right buttom.
Then select the [Update driver].

[Mouse right button click]

2. Follow the instructions below.
① Select [Browse my computer for driver software].

② Click the [Browse] button.

③ Select the [Driver] folder from the installation CD
file.

④ Add the [Driver], then click the [Next] button
.
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5. Click “Close” button to complete program
installation.

(3) Program Installation
Once the CD provided is inserted into the CD drive, the installation program is automatically being executed.
Unless the program is automatically run even after the CD is inserted, start the program in “Computer – CD
Drive”.
1.Setup wizard

2. Select installation folder

3. Confirm installation

4. The file is copied onto the hard disk.

5. Click “Close” button to complete program
installation.
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- Program Description
Once the installation is completed, the following icon appears on the desktop. The description on the icon is
as follows:

As a design & marking software program, it features the following functions:
marking design, marking option, Toolpath setting, transfer of Toolpath data.

As a product setting program, It features the following functions:
Laser focus, Guide laser, Roatary origin, Manual calibration.

- MagicArt Program Unlock USB
The program lock should be connected to the personal computer for run the program.

- Pogram password
Only administrators can use the program by using the program password.
Please make sure that chage the default password.
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(4) Manual Calibration
Check the setting value on the product’s left side.
✽It has different setting value each machine.
Manual Calibration
1. Model: G-F-J30R-J112F163-1-2
2. Focus Length: 1885
3. Guide Laser X: 5000
4. Guide Laser Y: 5002
5. Guide Laser Width: 1015
6. Guide Laser Height: 1023
7. Rotary X: 2985
8. Rotary Y: 3720
9. Focus Pointer X: 4610
10. Focus Pointer Y: 4920
Correction
1: 554, 595
2: 547, 597
3: 552, 589
4: 544, 591
5: 585, 579
6: 580, 570

<Example>

1. Run the [machest]. And select the [Manual Calibaration].
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7: 31191

2. Click the [Edit] button.

4. Enter the setting value, then click the [Apply] button.
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5. Click the [Yes] button, then the program will start.

6. Run the [machest]. And select the [Manual Calibaration] then select the [Correction]

7. Click the [Yes] button, then the program will start.
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(5) Installation of the blower
※Blower set is purchased separately.
-Order to connect the blower

Out take

In take

Machine
Outlet

Connect the hose to the outlet.

After connect the hose clamp,
Then screw the bolt by the wrench.
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(6) Auxiliary Power Device Setup (for external devices)
※ It is an option accessory.
Auxiliary Power Device is required when using the Dust Collector.
This device must be used if the external blowers or dust collectors have more than 2 Ampere.
Otherwise, this may result in a machinal failure.

Connect the Auxiliary Power Device to the Laser machine. (Refer to the picture below)

Connect to the Dust Collector

Connect to the Laser machine

Connect to the outlet
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5. Operation of Marking Machine
Switch on the product and connect the program. Then, the system performs self-examination as follows.
Unless a problem is found, it goes into a standby mode with confirm sound.

(1) Self-examination procedures when the system is turned on
1.
2.
3.
4.
5.

In case there is a sensed axis, move it out of the sensing zone.
Check the cover sensor.
Check the z-axis sensor and return back to the origin.
Return back to the origin.
Confirm sound and standby

(2) Marking procedures
1) Switch on the marking machine.

2) Start the program and connect it to the machine. Once connected, the system is reset, and the cover
is automatically opened.

3) Put the material on the working area.
(ex: Metal medal for Fiber Laser machine L100)
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4) Prepare the design to mark.

5) Click the [Marking machine] button and send the marking data.
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6) Set the laser focus, using the
buttons.
(ex: Metal medal for Fiber Laser machine L100)

* Height is adjustable on the program [laser option-Laser Focus-Material Height].
7) Click [Engrave] and send data. Then, check the marking position.

8) Click [Start] or press [

] long (2 seconds or longer) to start marking.
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6. Other Devices
[External Device] - Blower power prot : 110~220V/2A
1. Connect the power to the back of machine.

2. Click [OTHERS] in the [Setup Machine].

3. In case the AUTO checkbox is clicked in the External Device, the external device is automatically operated
even though the power is switched off.
* If the power is turned ON, the system is always ON regardless the AUTO control. *

The power is automatically turned OFF after being
delayed for the preset time in[Countdown before Power
[OFF].
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[Foot Switch]
1. Connect the power cable to the back of L100.

2. Click [OTHERS] in the Engraver Settings.

3. Able to use Foot Switch for user convenience such as repetitive operation

KEY Mapping
-Start: The system starts if the Foot Switch is pressed.
-Stop: The system starts if the Foot Switch is hit again.
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7. Clamp
A guideline can be checked at the working area.
The working area of product is L100 = 112x112(mm).

Put the material on the middle of the working area.
The guideline of the working area is same with the working area of MagicArt.
(ex: Metal medal for Fiber Laser machine L100)

<Clamp>
It is able to screw clamp bolts into working area holes.
Put the clamp and screw the clamp bolt.
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< Medal Clamp>
※Medal clamp is purchased separately.

Clamp Fixing part

Pin holes

Fixing
Fixing knob
knob

The holding part of clamp is step type, so set the clamp to the step to match the size and thickness are
matched. If you move the clamp moving bar to the upside, then turn the fixing knob to the right, the clamp
will be tightened.

When holding the materials by turning the clamp fixing knob, a mark may be left on the materials.

1. Fix the product working area by matching the pins to the holes.
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2. Connect the clamp pins to the clamp fixing unit.

3. Fix the pin on the clamp.
Pin holes on the clamp ensures easier holding of irregular shaped material.

4. Fix it by turning the fixing knob.
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<L Type Clamp>
※L type clamp is purchased separately.

Knob

Put the material tightly on the fixing bracket.

- Origin Setting
Set the L type clamp position to locate the focus at the center of the L type clamp groove. The end position
is the origin of L type clamp. Once the origin is set, it is easy return L type clamp to its original position even
after removal. If an x-axis flat clamp is removed, the origin should be reset.
1. Fix the clamp to set the focus. Set the position of L type clamp and then fix the x-axis (vertical fixation)
clamp.
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2. Put it tightly on working area with the clamp as a guide. Then, fix the position of L type clamp.

3. Set the focus, using the

buttons.

4. Adjust the position of L type clamp to locate the origin of the focus in the middle of the L type clamp
groove.

5. Fix the x-axis (vertical fixation) clamp.
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-Material Focus Setting
1. Put the material on the fixing bracket.

2. Set the focus, using the

buttons.
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<Honeycomb Table>
※Honeycomb table is purchased separately.
1. Put the honeycomb table on the honeycomb table tray.

2. Set the position of honeycomb table on the machine.
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<Rotary Clamp>
※Rotary clamp is purchased separately.
Connect the clamp fixing part to the working area hole. Connect the cable with the product and switch on
the power.
Angle Adjustment Handle

Power Button
Clamp Fixing Part

Marking Machine Cable

Rotary Clamp Graduations

Angle Fixing
Knob

The rotary clamp graduations are used in
marking the inner diameter of ring.
The recommended angle automatically appears
when entering a ring size.
(for the details, refer to the processes of
marking the inner and outer diameter of rings.)

1. Switch off the rotary clamp power before connect to product for safety.

2. Fix the product working area by matching the pins to the holes.
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3. Connect the clamp pins to the rotary clamp fixing unit.

4. Connect the product cable in the rotary clamp to the machine body.

*Please match to the groove.
There is a risk of breakage if connected without alignment.

5. Switch on the rotary clamp.

6. Close the clamp using chuck finger and fix the material.

32

- Holding method for outer diameter engraving
Put the ring into the chuck finger and fix it with the chuck handle.

- Holding method for inner diameter engraving
Insert the ring by widening the chuck finger of rotary clamp. Then, fix it with the chuck handle.

- Holding method for thin ring inner diameter engraving
When marking the thin rings, change to the 2mm chuckfinger by using the chuck finger spanner provided
along with the product to release.
Insert the ring by widening the chuck finger of rotary clamp. Then, fix it with the chuck handle.
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Program Usage Description
Run the program, then a window will show up as below. The program window is different in accordance with
modes. The names of parts for each case are as follows.

◈ Program screen
Menu

Toolbar

Template category

Template
list

Work area
Design sample
category

Design
sample list

Screen zoom in/out tools

◈ Text input mode
Press

[Text Input] button and click the screen or double click on the selection mode to switch to text

input mode.

Text property

Cursor (text input mode)
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◈ Object selection mode
After entering text, click
[Selection] button with a mouse or right-click the work area. Then, the
entered text object is selected and it turns into selection mode. Double click the selection mode to convert
it into text input mode.

Object property

Object selection mode

◈ Object rotation mode
If the selected object is clicked once more, the mode will be converted to the object rotation mode.

Rotation registration information

Object rotation mode
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1. Toolbar
◈ Alignment tools

[Line/Curve]
Click a certain point and drag it to make a dot line appear. Designate
the distance and click with the mouse and then right-click to create a
straight line. At this time, press “Ctrl” key on the keyboard and move
the mouse to create a horizontal line or a vertical line.
Click on a certain point and designate a distance. Drag while clicking
and holding the mouse to make a curve appear. Right-click to create
the curve.

[Circle/Ellipse/Pie]
Click and hold the work area with the mouse and drag it to designate
the size of a circle. At this time, press “Shift” key and drag it to create a
perfect circle.
Click
button on the circle object property window to transform
into an arc. The starting/ending degree can be designated and those
degrees can be adjusted by dragging the starting/ending degree of the
arc with the mouse. At this time, click
create a reversed image.
36

button to

Click
button on the circle object property window to transform
into a pie (a filled arc). The starting/ending degree can be designated
and those degrees can be adjusted by dragging the starting/ending
degree of the pie with the mouse. At this time, click
button to create a reversed image.

[Rectangle]
Click and hold the work area with the mouse and drag it to designate
the size of a rectangle. At this time, press “Shift” key and drag it to
create a square.
Determine the curvature of each edge on the rectangle object property
window or drag the rectangular edge with the mouse to transform it
into a rectangle with round corners.
Click
button on the rectangle object property
window and adjust the curvature of each corner individually.

[Polygon]
Click and hold the work area with the mouse and drag it to designate
the size of a polygon.
At this time, specify the number of vertical on the polygon object
property window to change it.

[Mirror]
Left/right reverse the selected object.

[Rotation]
If the selected object is clicked once more with the
mouse, it will convert to the object rotation mode.
Then, rotate the object by dragging it with the mouse
or arrow keys on the keyboard.

[Invert color]
Reverse the color of the selected object.
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[90˚CW]
Rotate the selected object by 90˚.

[Vertical center in page]

[Horizontal center in page]

[Center in page]
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Align to the left of base object
Align to the center of base object
Alignment

Align to the right of base object
Align to the top of base object
Align to the center of base object
Align to the bottom of base object

Adjust horizontal gap
Adjust vertical gap

Expand horizontal gap
Expand vertical gap
Make same width

Same size

Make same height
Make same size
Bring to front

Order
Send to back
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◈ Object tools

[Design sample]
Import design sample or save current object as design sample.

What is a design sample?
It means design objects saved in the design sample library. The design sample is easily and
quickly imported from the design sample library and freely edited.
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[Selection]
It is available either to select the object created in the work area to adjust its size and location or to
change the object’s property. Only the selected objects are subject to change their options such as
location, size, etc. In the text input mode, convert to selection mode easily by right-clicking the work area.

[Object selected]

[No object selected]

[Text input]
If
button is pressed and the work area is clicked with the mouse, then characters can be entered.
Double clicking in the selection mode is an easier way to convert into the text input mode.

Cursor (Text input mode)
Press
and size.

button and drag a character to edit with the mouse for partly selection. Then, adjust its font

[Mouse drag]

[Circular text]
Create text objects along a circle.
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[Drawing pen]
Subject can be drawn by dragging the mouse.
The thickness of drawing line can be adjusted in the drawing object property window.

[Outline stroke of object]
The image in a rounding box can be inserted into the target page
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[Invert color of overlapped area]

When two or more objects are overlapped, the color in overlapped area can be inverted.
Move the target object over the first object after clicking
converted.
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button, then overlapped area’s color will be

When converting text, drag the target object over the text after clicking

button.

• [Invert color in overlapped area] function is only applied to straight lines, curved lines,
circle, rectangle, polygon, design sample and uploaded SVG file, not texts and images.
• [Invert color in overlapped area] function inverts the color of underlaid object.
If the color is not converted, select [Layout menu → Z Order → Top Most] and place the
underlaid object above the other object.

[Image]
Import image (bmp, jpeg, gif, png … etc.).
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[Line eraser]
Clear the line of object.
Move the mouse over the line of object, then click the line. The line will be erased (Some objects cannot
be erased with the Line eraser tool).

◈ Toolpath

Toolpath?
Toolpath is a pathway where tool goes by for marking.
Toolpath is usually displayed in red color and marking tool goes on the pathway as it engraves.
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◈ Origin point tools

[Left top origin point]
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[Left bottom origin point]

[Center origin point]
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◈ Basic tools

[New document]
Open a new file.
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[Open]
Open a file in “*.dgn” file format.
Select a file on the “Open” window and click “Open” button.

[Save document]
Save the design drawn on program by “*.dgn”.
Choose the location(folder) in which the file will be saved and enter the file name before clicking “Save”
button.

[Print]
Print the design drawn on program.

[Cut]
Cut the selected object.
If Ctrl+X is pressed on the keyboard, the same function will be executed.

Ctrl + X

Ctrl + V

[Copy]
Copy the selected object.
If Ctrl+C is pressed on the keyboard, the same function will be executed.

Ctrl + C

Ctrl + V

[Multiple paste]
If more than one of the same objects is needed, multi-copy the object in several constant gaps by
clicking Edit menu → Copy → Multiple Paste….
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[Paste]
Paste the cut or copied object.
If Ctrl+V is pressed on the keyboard, the same function will be executed.

[Undo]

Return the work recently done to its previous state.
The number of undo stage can be adjusted with Tool menu → Option → General.

Undo

Change font

[Redo]

Re-execute the undone work.

Change font

Undo
Redo
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◈ Screen zoom in/out/move tools

[Zoom in]
The screen is zoomed in by one level.

[Zoom out]
The screen is zoomed out by one level.
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[Zoom in/out ratio]
If any screen ratio is selected, the screen in the size of the selected ratio will be seen.

[Magnifier]
Drag a certain spot with the mouse to enlarge it.

[Fit to object]
Enlarge the selected object to make it filled in the screen.

[Fit to page]
Adjust the page size to see the whole work area.
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[Panning]
Drag the screen with the mouse to move it.

2. Text object property
If any text object is selected, the property of the text object will appear on the left of the screen.

[Font]
Designate font. Either click the font’s arrow or click “Preview” button to designate font.
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Right click to display menu on font preview window. Click “Show Font List”, then you can designate the fonts
that will be used in preview.

[Mouse right button click]

[Size]
Adjust the size of the selected text. Either press the size arrow button to select or press
button to adjust the size by one level.

[Bold]
Change text style to bold.
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[size]

[Italic]
Change the text style to italic.

[Reduce or increase font weight by one level]
Adjust the weight of font.

[Symbol]
Insert symbols.

[Text change]
The entered text of the selected object can be displayed and changed. Edit the text on the text field or
press

button to change the text more easily when several text objects are selected.
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[Align]

Align characters to the left in the text box.
[Align to left]

Align characters to the horizontal center in the text box.
[Align to center]

Align characters to the right in the text box.
[Align to right]

Align characters to the both direction evenly in the text box.
[Both]

Align characters to the top in the text box.
[Align to top]

Align characters to the vertical center in the text box.
[Align to center]

Align characters to the bottom in the text box.
[Align to bottom]
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Arrange characters horizontally.
[Horizontal text ]

Arrange characters vertically.

[Vertical text]

Move the selected character horizontally (left, right).

Move the selected character vertically (up, down).

Adjust the width of the selected character.

Rotate the selected character.
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[Position/Size]

Location of the selected object

Size of the selected object

When “Keep Ratio” is checked, width and height of the selected
object is maintained at the same rate.
When “Keep Ratio” is un-checked, width and height of the selected
object is adjusted separately.

[Line and Fill Shape]

Line thickness of the selected object
Line type of the selected object
Line color of the selected object
Color filled inside of the selected object
Type filled inside of the selected object
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3. Rotation tool property

[Rotation]

Rotate the selected object by designated degree. Enter the
desired angle of rotation, and then press arrow button.
object is rotated by the angle entered.
Rotate the selected object at the same degree as entered.

Rotate and add a new object at the same degree as entered
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The

4. How to engrave for each toolpath

Toolpath?
Toolpath is a pathway where tool goes by for marking.
Toolpath is usually displayed in red color and marking tool moves on the pathway as it
engraves.

[Cut-out toolpath]
Creates a toolpath that will cut out the selected object. The toolpath boundary will be wider than the
selected object’s boundary depending on the diameter of tool.

[Outline toolpath]
Creates a toolpath that will engrave the selected object’s border.
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[Scan line toolpath]
Creates toolpath that will engrave inside area of the target object’s boundary.
“Scan line toolpath” might be similar to “Hatching toolpath”, but it is rather used for logos, patterns or
objects with larger area.

[Single line toolpath]
Creates a toolpath that will engrave the center line of the selected object.

“Single line toolpath” process may cause the line deviated.
Thus, it is recommended to use thinner lined font to reduce the deviation.

[Photo impact engraving toolpath]
Creates a toolpath that will engrave image with dots.

61

[Simulate toolpath cut]
The prospected image of the toolpath outcome processed by the selected tool is shown.
The following is an example of the cutting toolpath that uses 0.6mm endmill cutter.

[Show toolpath only]
Only toolpath is shown on the screen with temperately masking all of other objects. If this button is
pressed once again, all objects will be seen again.
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5. Create Toolpath

Laser Beam Info

Preset

Select the laser beam. Each engraving option value can be changed by
pressing Edit or Add button.
Hatching gap, depth, engraving speed and others are pre-set for each
engraving option. Therefore, it is not necessary to designate hatching
gap, depth, engraving speed and others every time and they will be
automatically set with their pre-set values. Each engraving option
value can be changed by pressing Edit or Add button.
Designate hatching gap.

Hatching
Gap

0.1mm
0.2mm
0.3mm
Designate a margin between object outline and toolpath.

Option

Margin

0.1mm
0.2mm
0.3mm
The followings are shown only on hatching Toolpath.

A Toolpath is created in the horizontal direction
Direction
A Toolpath is created in the vertical direction
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A Toolpath is created in the left diagonal direction
A Toolpath is created in the right diagonal direction
A Toolpath is created in the cross hatched direction
※ This toolpath is not recommended due to possible
damage to materials with plated surface.

If this option is un-checked, a toolpath for only the inside of the
selected object is created.
Engrave
outline

Transmit
Create Toolpath

Toolpath output window is displayed.
Create the toolpath.

(1) Laser Beam Info: Add/Delete/Edit
If “Edit” button is checked, Add/Delete/Edit buttons will appear.

Designate the name of a info to be added along with its type and other options like tip width,
then click “OK” button. The new info will be added to the selection list.
Select a info from the list and click “Delete” button to delete the selected tool from the list.
Select a info for modifying and click “Edit” button. If “OK” button is clicked after option is
modified, the modified value will be saved.
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(2) Preset: Add/Delete/Edit
If “Edit” button is checked, Add/Delete/Edit buttons will appear.

Enter a name to the preset option setting window and designate hatching gap, engraving depth
and etc before clicking “OK” button. The option will be added to the preset option selection list.
Select an option to be deleted and click “Delete” button to delete the option from the list.
Select an option to be modified and click “Edit” button. If “OK” button is clicked after option is
modified, the modified setting value will be saved.
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6. NC data output
Select toolpath and click product button on the top-right of screen to transfer the selected toolpath to the
product.

When the machine is identified, the model name will appear on the
button.
“NC output” window appears when this button is clicked.

On the NC output window, select a measuring method and other options, then click “Start Engraving” button
to start transferring the toolpath to the selected product.

Toolpath order

Multiple engraving
Start Engraving

When two or more toolpaths are selected for engraving, they will
be placed in order. The order can be adjusted by [Up], [Down]
button on the right.
Engraves materials repeatedly in constant vertical/horizontal gap.
✽Usually optional clamp is used for this automatic engraving.
Start engraving.
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[Transfer of Tool Path Data Right after Text Entry]
Able to mark a selected object immediately without creating a tool path

Type of
Engraving
Laser Beam Info

Able to select a marking method such as edge and scan line
A tool path is automatically generated by the selected marking method. Options
can vary depending on a type of the selected tool path.
Chooses a laser beam option
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Preset

Hatching interval and direction are already set by option. Therefore, if a tool path
option is chosen, the preset values are automatically set.
Displays a tool path according to the selected fragment option

Toolpath
Preview

ex> Select the scan line

Multiple
Engraving

Able to mark a selected object repeatedly with a certain width/length interval
It allows users to automatically fragment a lot of works at a time by entering clamp
information and marking size.
✽ AUTOMATIC MARKING is available with a special clamp. This special device is
sold separately. To get this, contact the store.
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Laser Option
Click the [
(IMP-L100)] button / [Toolpath] button to send the Toolpath. Then, a laser option
window pops up. Adjust the laser option and click [Engrave]. Then, the marking data are sent to the product.

Engraving object
Preset

Checks the object to engrave
Selects the engraving option * See the details at the below.
Changes the laser option * See the details at the below.
Changes the advanced option

Advanced
Option

Power
Option

Frequency

Adjusts the laser frequency

Speed

Adjusts the speed

Repeat
Count

Adjusts the repetition frequency

Depth

Adjusts marking depth at selection of Deep Marking

Z-Movement

Cleaner
Relocation
Material
Laser
Focus

Adjusts the laser output

Material hight

The depth specified at selection of Deep Marking is not marked at
a time. It is adjusted by Z-axis moving unit.
E.g.) Deep Marking-specified depth:
In the event of 1.2mm/0.03mm Z-axis moving unit, 1.2mm depth
is marked (0.03mm per marking, 4 times).
Perform the engraving for trimming.
Moves the laser position
Selects the preset engraving height * See the details at the bottom.
Since the laser focus changes according to the height of the
material, the height is adjusted accordingly.
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1. Engraving Option
Laser options such as engraving type, power and speed can be set in advance.
Press [EDIT] and click the button at the bottom. Then, you can change options.

<Add>
This menu is used to add a new engraving option.
Set the options (e.g., name, engrave type, power, frequency, speed, etc.) and click [Save].
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<Edit>
This menu is used to edit engraving options.
Edit the options and click [Save].

<Delete>
Deletes engraving options
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2. Options
Engraving types can be selected. Laser options change depending on an engraving type. Adjust the value
and click [Save Option].

3. Material
The height of laser focus can be set by material.
Press [Edit] and click the button at the bottom to change options.

<Add>
This menu is used to add new material setting.
Set the name and material height and click [Save].
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<Edit>
This menu is to edit material setting.
Change the option and click [Save].

<Delete>
Deletes the material option
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4. Rotary Engraving Option
In case of rotary engraving, the diameter and width information which were entered at design by MagicArt
is reflected and stated as it is.
Then, laser focus is automatically set, using the value.

In case of inner diameter, angle is calculated and informed.
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5. Laser Option by Toolpath
There are differences in laser options by Toolpath.
<Cutting Toolpath>
- Overpath: Improves cutting completeness by cutting from the starting point to the preset value with laser.
- Move Focus: Same with the focus depth setting. When cutting the engraving depth little by little,
designate the depth.

<Image Engraving Toolpath>
- Point Number: Since an image is engraved with tiny points, the degree of image-engraving completeness
can be adjusted by setting the number of points engraved at a time.
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Marking Process
● Machine: Fiber Laser Machine L100
● Material: Aluiminum pendant
● Toolpath: Scanned Line

1. Measure the size and height of a material.
Height

Width
Thickness

2. Place the material on the working area and set the laser focus, using

buttons.

(Ex: Fiber laser machine L100/ aluiminum pandant)
3. Once a template appears, click [
(Enter/edit characters)]. Move the mouse pointer to a wanted
position and click it. Then, enter the characters.
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4. Once characters are entered, click [
(Select)] on the toolbar and open the Select Object mode. Then,
select the entered character and edit its size, font and boldness. To put the object in the middle of the work
area, click [

(alignment in the middle of a work area)].

5. Once the design is completed, click [
tools.

✽ Click [

(Scanned line Toolpath)]. A Toolpath refers to a path way of

(IMP-L100)] on the right top without creating a Toolpath for immediate Marking.
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6. Select an option on the Toolpath page. If necessary, set the hatching interval and click [Create Toolpath].

7. A Toolpath object is being created.

Click [

(IMP-L100)] on the right top.
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8. If the NC Output window appears, click [Start Engraving].

9. A laser option window pops up. Select the Laser Option and click [Engrave]. Then, a Start page appears
with a warning message. Click [Start].
(If the laser focus is set in advance when a material is placed, it is unnecessary to enter height at a laser
option.)
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10. Once a red laser pointer on the material is turned on, check and adjust the position of the pointer, using
the direction keys.
The area pointed by the red rectangular laser pointer refers to an actual marking zone. The round laser
pointer in the middle represents the origin of the height of laser focus.

Whenever the direction key is pressed, the laser pointer moves
up/down/left/right, showing an marking area. Check if the marking zone is
matched with the area on the material to be actually engraved. If
unmatched, adjust the position, using the direction keys.

Once the direction key is pressed, the laser pointer moves
up/down/left/right in the marking zone. In other words, if a laser pointer is
situated on the left side, press [

] to move the marking zone to the left.

11. Once the marking position setting is done, click the program Start button or [
] on the product long
(2 seconds or longer). Then, the cover is automatically closed, and marking begins.
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Marking Process of Ring inner/outer Diameter
● Machine: Fiber Laser Machine L100
● Clamp: L type clamp or Rotary clamp (Optional)
● Material: Metal ring
● Toolpath: Scanned Line

◈ Preparation
1. Measure the width and diameter of a ring to be engraved.

Width

Diameter
2. Insert the ring into the chuck finger as below, and tighten the L type clamp to set it.

◈ Program Process
1. Double click “Ring” template in the object property window.
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2. When “Insert Rotary Object Template” window appears, enter the measured width and diameter of the
ring and click “OK.”

3. The template appears at the center of the screen.

4. Select

[Text Input] on the toolbar, and click the work area using mouse and enter text to be engraved.
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5. After entering text, press

[Selection] on the toolbar to enter the object selection mode. Select the

text, and edit the size and font of the object. To place the object at the center of the work area, click
[Center in Page] button.

Handle to adjust
character gap

Handle adjusting gaps between characters?
A function adjusting gaps between characters by dragging characters to target positions.

6. Once design is completed, click

[Scanned line Toolpath] button.
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7. Once “Hatching Toolpath” window appears as shown in the picture below, select tool, toolpath gap and
depth, and click “Create Toolpath” button.

-Marking at Fixed Angle when rotary marking: Engrave the each text.

8. The “Toolpath” object is created as below and usually marked with red line on the screen. Scroll the
mouse wheel to enlarge the toolpath object, and if it is not the desired toolpath, delete the toolpath and
create it again by adjusting the toolpath option.
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9. The toolpath angle is shown as below based on the entered ring size data and text length.

10. After selecting one or more created toolpaths, click

11. Once “NC Output” window appears, click “Start Engraving” button.
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button.

<When marking the outer diameter>
- L type clamp
※L type clamp is purchased separately.

-Roatary Clmap
※Rotary clamp is purchased seaperatly.
When operating with rotary clamp, a marking error can be reduced by measuring the height of a material
and entering it into a program.
Tightly fix the material to the rotary clamp and measure a height from the laser engraver surface to the
marking area, using an accessory ruler.

57mm

Enter the height into the [Material Height] in the option and click [Apply].
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<When marking the inner diameter>

If inner diameter is selected, it is able to check angles automatically stated, using the diameter and width
values.
*In case of inner diameter marking outside the limit of 20°, marking may not be possible.
*If outside the indicated angle and the marking position, marking may not be possible.
-L type clmap
※L type clamp is purchased separately.
After loosen the fixing knob, Adjust the angle then fasten the fixing knob.

-Roatary Clmap
※Rotary clamp is purchased separately.
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After loosen the angle fixing knob, Adjust the angle by turning the angle adjustment handle.

*Adjust the angle based on the bottom of the angle bar.

Then fix it by turning the angle fixing knob again.

When operating with rotary clamp, a marking error can be reduced by measuring the height of a material
and entering it into a program.
Tightly fix the material to the rotary clamp and measure a height from the laser engraver surface to the
marking area, using an accessory ruler.
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For ring inner diameter marking, measure the height after specifying a marking surface according to the
marking position.
E.g.1) In case the outside of the inner diameter of a ring is marked, measure and enter the height of the
outside of the secured ring.
Then, measure the height based on the center point of the marking area.

Measure the center point of the
marking area
75mm

E.g.2) In case the inside of the bore of a ring is marked, measure and enter the height of the inside of the
secured ring.
Then, measure the height based on the center point of the marking area.

Measure the center point of the
marking area
73mm

Enter the height into the [Material Height] in the Option tab and click [Apply].
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12. A laser option window pops up. Select the Laser Option and click [Engrave]. Then, a Start page appears
with a warning message. Click [Start].
(If the laser focus is set in advance when a material is placed, it is unnecessary to enter height at a laser
option.)

13. Once a red laser pointer on the material is turned on, check and adjust the position of the pointer, using
the direction keys.
The area pointed by the red rectangular laser pointer refers to an actual marking zone. The round laser
pointer in the middle represents the origin of the height of laser focus.

Whenever the direction key is pressed, the laser pointer moves
up/down/left/right, showing an marking area. Check if the marking zone is
matched with the area on the material to be actually engraved. If
unmatched, adjust the position, using the direction keys.

Once the direction key is pressed, the laser pointer moves
up/down/left/right in the marking zone. In other words, if a laser pointer is
situated on the left side, press [
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] to move the marking zone to the left.

14. Once the marking position setting is done, click the program Start button or [
] on the product ong
(2 seconds or longer). Then, the cover is automatically closed, and marking begins.
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Photo Marking
What is photo marking?
This is an marking method to display the shade of image with dots.

● Machine: Fiber Laser Machine L100
● Material: Metal pendant
● Toolpath: Photo Impact Engraving

1. Place the material on the working area and set the laser focus, using

2. Click

[Image] to import an image for marking.

92

buttons.

3. Adjust the size and location of the image.

[Mouse drag]
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4. [Clipping Mask] function enables cutting out target area extracted from the image.
Create a shape to designate the target area and drag it on to the image.

[Mouse drag]

5. Drag a mouse to select the target area and the whole image.

[Mouse drag]
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6. Select [Transform] menu → [Make Clipping Mask].

7. The target image remains except the outer image.
The whole actual image is already saved in the file, not erased.
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8. Click

[Photo Impact Engraving Toolpath] button.

9. Adjust marking option in photo marking option window.

✽ The black area cut by clipping mask is not being engraved.
When marking a photo, bright part (white area) of image is expressed in dots. Since darker image
shows higher quality, adjust the brightness darker. Normally, dot ratio 10-20% shows the best
marking quality for a portrait. The optimal image condition depends on the brightness of
background of the image. Adjust the image monitoring the image preview and the dot ratio.
If ‘image adjustment’ is confusing, click “Recommend the best” button to automatically adjust the
image.
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10. Click “OK” button to create toolpath for photo marking. Double check the created toolpath and click
button.

When marking a photo, white area of image appears as a dot. So the result of the toolpath is
shown as negative image.

11. Once “NC Output” window appears, Click “Start Engraving” button to start transferring the toolpath to
the selected product.
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12. A laser option window pops up. Select the Laser Option and click [Engrave]. Then, a Start page appears
with a warning message. Click [Start].
(If the laser focus is set in advance when a material is placed, it is unnecessary to enter height at a laser
option.)

13. Once a red laser pointer on the material is turned on, check and adjust the position of the pointer, using
the direction keys.
The area pointed by the red rectangular laser pointer refers to an actual marking zone. The round laser
pointer in the middle represents the origin of the height of laser focus.

Whenever the direction key is pressed, the laser pointer moves
up/down/left/right, showing an marking area. Check if the marking zone is
matched with the area on the material to be actually engraved. If
unmatched, adjust the position, using the direction keys.

Once the direction key is pressed, the laser pointer moves
up/down/left/right in the marking zone. In other words, if a laser pointer is
situated on the left side, press [
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] to move the marking zone to the left.

14. Once the marking position setting is done, click the program Start button or [
] on the product long
(2 seconds or longer). Then, the cover is automatically closed, and marking begins.
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Cutting Process
※Honeycomb table is purchased seaperatly.
1. Measure the thickness of a material to be cut.

2. Place a material to be cut on the honeycomb table and place it on the working area.
Then set the laser focus, using

buttons.

3. Press
[Text Input] on the toolbar to enter the text input mode, and click the work area you want and
enter the text.
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4. After entering text, press

[Selection] on the toolbar to select the text and designate the font.

Adjust the text to the desired size. The size can be adjusted by using an object handle(a square in the
picture below) as below, or from the object property window.
Object Handle

5. Drag the text gap adjustment handle (a square in the picture below) with the mouse to narrow or widen
the gap between the characters.
Object Handle

[Mouse drag]
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If the gap of some characters is partially adjusted, press
[Text Input] button and drag the mouse to
select characters you want. Drag a text gap adjustment handle with the mouse and adjust the gap.

[Enter text]

[Press

[Select characters]

button and click with the mouse]

[Adjust character gap]

6. Insert a type of ring connected to the characters from the design sample section.

7. Select a type of ring and double click it to load in the work area.

102

8. [Copy] and [Paste] the ring type, then guideline for a location of the ring appears. Adjust the location
and click the spot.
Copy the target object by pressing [Ctrl+C]

Paste the target object by pressing [Ctrl+V]

Confirm the location and click the spot.

9. Select all the objects for the design, right-click on it to see the menu and select [Group].

✽Selecting the whole objects: Drag the object with mouse or select
Edit menu → Select All.
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10. Once the design is completed, click

[Cut-Out Toolpath].

11. Once the “Cut-Out” window appears as seen in the figure below, select tool to be used for the cutting,
input the measured material thickness and the other options and click “Create Toolpath.”
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12. “Toolpath” is created.

13. Click

button.
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14. If the NC Output window appears, click [Start Engraving].

15. A laser option window pops up. Select the Laser Option and click [Engrave]. Then, a Start page appears
with a warning message. Click [Start].
(If the laser focus is set in advance when a material is placed, it is unnecessary to enter height at a laser
option.)
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16. Once a laser on the material is turned on, check and adjust the position of the pointer, using the
direction keys.
The area pointed by the red rectangular laser pointer refers to an actual marking zone. The round laser
pointer in the middle represents the origin of the height of laser focus.

Whenever the direction key is pressed, the laser pointer moves
up/down/left/right, showing an marking area. Check if the marking zone is
matched with the area on the material to be actually engraved. If
unmatched, adjust the position, using the direction keys.

Once the direction key is pressed, the laser pointer moves
up/down/left/right in the marking zone. In other words, if a laser pointer is
situated on the left side, press [

] to move the marking zone to the left.

17. Once the marking position setting is done, click the program Start button or [
] on the product long
(2 seconds or longer). Then, the cover is automatically closed, and marking begins.
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Curved Material Marking
For marking on curved surface, select a curved template. Enter the height and length of the curved surface.
Then, z-axis automatically moves along the surface and marks letters one by one.

In terms of marking on curved surface, texts are only available.

1. Select the CURVED template.
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With the curvature information, z-axis shift is calculated. Therefore, if an incorrect size is entered,
z-axis error can occur.
Height

width

When entering curvature information, put the material on the floor as shown in the figure. Then, enter the
distance between the two points which touch the floor.

Depth

Width

2. Enter texts and create a tool path. Then, z-axis information appears on the screen as shown in the figure
below:
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3. Send data and start marking. Then, z-axis automatically moves and marks according to angles.

E
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Shape Distortion

Due to curvature, text and shape can be distorted during laser marking. If marked under this mode, such
distortion can be corrected.
- Check the guide laser on your own and enter the distortion value.
- This function is available for figures and texts only (NOT for pictures and circular texts).

[Figure Shape Distortion]
Able to distort the shapes of the figures provided by MAGIC ART
Create figures and click [Menu] → [Transform] → [Distortion].
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[Text Shape Distortion]
If [Distort Shape] is clicked without converting an object into a curve, texts are distorted one by one.

1. Enter texts and click [Menu] → [Transform] → [Convert to Curve].
(Or select an object and right-click → [Convert to Polygon])

* Texts change to figures when converted into curves so that they cannot be edited.
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2. Once texts are converted into curves, change [Fill Shape] to [Infill] in the SHAPE on the left.
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3. Click [Menu] → [Transform] → [Distortion].

4. Enter shape and values. If a negative value is entered, a direction of distortion changes.

5. Enter shape and values. If a negative value is entered, a direction of distortion changes.
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Layout of Text in a Circle
Text can be laid out in a circle by using circular text object.

[Circular Text]
Click
button to display “Circular Text” window. Designate direction and angle, enter size and text,
then click “OK” button.
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Adjusting layout angle
Drag the first character [R] or last character [y] in the text to adjust the angle of the layout.

Drag with mouse to adjust
the layout angle.
Drag other characters with mouse to adjust the distance to the center of the circle.

Drag with mouse to adjust
distance from the center of
the circle.
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Layout of Text on a Curve
1. Click the

[Line/Curve] button.

2. Click on a certain point with the mouse and designate a distance. Drag the mouse to make a curve appear.
Press the right button on the mouse to create the curve.

[Mouse drag]
3. Select “No Line” on the “Line and Fill Shape” window on the object property window.

4. Click
[Text Input] button, and move the mouse cursor to the curve line. The cursor shape will
change as below.

5. In state of the changed cursor shape, click to enter the text input mode.
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Font Preview
Apply the fonts installed on the computer to the text objects and preview the shape to select the most
suitable font.
Select text object, click “Preview” button in the object property window or right-click the mouse and select
“Font Preview” menu. Then, “Font Preview” window will appear.

Drag the font list in the font preview window, or click a font while pressing “Ctrl” or “Shift” key, then the
preview of the selected font appears automatically. Double click the preview image of the font to select it.

[Mouse right button click]
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Text Change
The text contents in text objects can be easily changed by the “Text Change” feature.
Import a saved design sample, file, or select text objects designed on the screen. Click
button or right- click the mouse, and select “Text Change” on the menu.

[Text change]

Change contents in the “Text Change” window, and click “OK” button. The changed texts will be shown on
the screen.

119

Template Creation
Template is an image corresponding to the materials to be engraved by 1:1 ratio. Load a template that is
the most similar to the material to be engraved, and enter the text to be engraved. This way allows you to
create the location of marking and the size of text to be engraved more easily and conveniently. Circle,
heart, square and diamond-shaped templates are initially provided by the program and users can freely add
more templates.
The shape of a template can be designed by graphic program (Illustrator, Photoshop, CorelDraw and etc.)
and loaded by SVG file format. Also scanned image file such as jpeg, bmp, png, etc. can be applied as
template.

[Creating template #1]
1. Select Tool menu → Template → Create Template from Image.

2. "Create Template from Image” window appears.
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3. Select image files (jpeg, bmp, png and etc.) from the “Open” window, and click “Open” button.

4. Input size of the template.
Check “Save” to save the loaded image as a template for later use and enter a name for the template.
Click “OK” button to load the image as a template. If “Save” is checked, and the template name is given, the
loaded image will be saved as a template in the template library simultaneously.
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✽ Right-click in the template category window for more template related features. The template can be
deleted by “Delete” on the menu that appears by right-click in template list window.

[Mouse right button click]
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[Creating template #2]
1. Press

[Image] button to import an image.

2. Select Tool menu → Template → Save Selected Object as Template.
Type a name of new template on “Input” window.
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3. The saved template is added in the template library.

The template saved in the “Save Selected Object as Template” menu is saved as designated
size to the screen. When loading the template, check “Maintain Original Size”, then the
template will be loaded with the original size designated when saving the template.
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Saving as Design Sample
Edited contents can be saved as design sample for easier access to the design.

[Saving as design sample #1]
1. Edit contents and select the objects.

2. Click File menu → Save as Design Sample and select a folder or create new folder.
Enter the name and click “Save” button to save it.
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[Saving as design sample #2]

1. Select objects, and click

[Design Sample] button.
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2. Select a folder to save the objects from design sample library window.

3. Click
[Save selected image as sample] or right-click the design sample image, and click “Save
Selected as Design Sample” menu.
Enter the name to be saved, and click “OK” button to save it in the design sample library.

[Mouse right button click]
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Auto Change of Serial Number
Use this function when changing numbers by certain unit.

1. Edit the font and size of text object with number, and press “Alt+N” key on a keyboard, or select Text
menu → Serial Number → Advance Serial Number to change the number automatically.

2. Select Text menu → Serial Number → Serial Number Option and enter a unit from the “Serial Number
Auto Advancing Option” to change the serial number by the designated unit automatically.
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3. If the serial number is not regular, then select Text menu → Serial Number → Load Serial Number.
Enter serial number in the “Lines to export” field or click “Load File” button to load it from a file (.txt or .csv
file format).
Once serial numbers are loaded, click “Export to object” button. The text on the selected text object is
automatically changed, and the serial number is deleted from the list. The deleted numbers will be shown
in the “Exported Lines”.
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Serial numbers can be loaded from comma separated values file (.csv) or text file (.txt).
Each row of the file is recognized as one serial number, and the contents of each row separated by
comma are shown in the next line.
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Loading and Editing Image
1. Loading an image
This program provides a function to load various types of image files. Supported image file types are as
follows.
BMP
GIF
JPG/JPEG
PNG
PCX
TIF/TIFF
WMF

Windows or OS/2’s bitmap graphic file
CompuServe graphic file
JPEG bitmap graphic file
Portable Network Graphics bitmap graphic file
Z Soft PC paintbrush bitmap file
Tagged Image File Format bitmap file
Windows meta file

Image file can be loaded by following method.
1. Select

[Image] on the toolbar or select Insert menu → Image.
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2. When “Open” window appears as the figure below, select the image to be loaded, and click “Open” button.

3. Drag the work area with the mouse to load the image by desired size.
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2. Converting and editing image
Only single color image can be engraved. Since multiple color images cannot be engraved by product, it
should be converted to single color (1 bit) image.

[Converting to single color image]
1. Select the image object you want to convert, and click “Convert” button in the image object window and
select “Monochrome (1bit).”
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Or select the Transform menu → Bitmap → Mode → Monochrome (1bit).

2. “Color Image to Black & White” window appears as below. Adjust the slider to change it to the most
suitable single color, and click “OK” button.
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[Editing image]
Loaded image can be edited by “Paint” program in Windows.
Select the image object to be edited, right-click it to select “Edit” or select Transform menu → Bitmap → Edit.

Click [OK] to run Windows Paint program.

Then, Windows Paint program will show the image.
After editing the image, press “Save” from the File menu of Paint, and close the program to apply the edition.
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Import a File in SVG Type
Loading vector graphic files such as SVG file is also supported.
The SVG file is created by various graphic programs such as Illustrator, CorelDraw and etc.
1. Select File menu → Save As from Illustrator program to save a file in SVG type.

2. SVG option window appears. Press “OK” button to complete the save.

136

3. Click

button to load the SVG file.

4. Or select File menu → Import to import a file.
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Product Setting
※ The product is being released in default setting. Please contact the customer service center before
changing the setting.
※ Set the product in the following order: Laser Focus Calibration - Guide Laser Calibration-Rotary Origin
Calibration.
※ An product setting program is separately provided. Start the program first to set the marking machine.
※ Calibrate a proper material according to the marking machine. The warranty shall not cover any damage
resulting from the use of an improper material.

※ Choose a metallic material.

1. Laser Focus Calibration
Calibrate the laser focus according to the height of a material and improve marking accuracy.
It is divided into 4 stages. In each stage, the head moves according to the distance specified in the previous
stage, and the moving interval shortens.
1. Switch on the machine.
2. Place a material (length: 80mm, width: 40mm) on the working area.

※ Choose a metallic material.
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3. Click [Laser Focus] on the Product Setting.

4. After checking the message, click [Next]. Then, the laser focus calibration procedure appears.
Enter the height of a material.

5. Check the warning message and click [Start].
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6. The numerals and circles are engraved on the fixed material.
The numerals range from ‘01’ to ‘10’. However, the numerals actually engraved can differ depending on the
laser focus.

7. Enter the middle number among the engraved numerals on the Engrave Machine Setting page and click
[OK].
※ E.g.) In this example, ‘5’ is positioned in the middle. Therefore, ‘5’ is entered.

8. Repeat the processes (Clauses 5-6) 4 times and finish the calibration with the laser focus-optimized
options.
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2. Guide Laser Calibration
Calibrates the size and position of a guide laser.
1. Place a material on the working area.

※ Use a metallic material.

2. Click [Guide Laser] on the Product Setting.

3. Check the message and click [Next].
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4. Set the size and height of a material (a rectangle to be marked) and click [Apply].
To mark the rectangle, click [Mark]. Then, the cover is automatically closed, and the rectangle is being
engraved on the material.

Marking
Line

*A 20mm rectangle is being engraved on the 0.5mm-high material.*

4. Once a guide laser appears after the end of marking, adjust the offset values, width and height according
to the rectangle in ‘2. Parameter Setting’ and click [Apply]. Or, move it using the
buttons and click [

] long (1 second or longer) to end the calibration.
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* Select the laser option on the Guide Laser page and adjust laser options.
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3. Focus Pointer
Set the position of the head laser pointer and V laser pointers.

1. Select [Focus Pointer] in the Engraver Settings.

2. Adjust to make head pointer in the center of the cross on the workspace, using the arrow buttons. Then,
click [Next].
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3. Place the flat material on the workspace and enter the thickeness. Then click [Next].

4. Pess the ▶ button on the right and proceed sequentially. (2mm wrench is required.)
All step is 4 step, both pointer must proceed in the same way.
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4. Rotary Origin
1. Fix the rotary clamp to the working area.
2. Click [Rotary Origin] on the Product Setting.

3. Fix the tool with a sharp edge to the rotary as described below:

4. To position the laser pointer at the tip, adjust the product with the direction keys. Then, click [Next]. Or,
adjust the position, using the

buttons and click
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long (1 second or longer).

5. Remove the fixed tool, then Insert the ring into the chuck finger as below, and tighten the rotation
clamp to set it.

6. Move to the stage II. And insert the ring size on the program.

7. Move to the [H pointer] to the center of the ring by using arrow buttons. Then, click [Complete].

147

5. Manual Calibration
Reference to the [4. Installation → (4) Manual Calibration] in page 13.

6. Correction
When the laser passes the scan head and comes all the way through the lens, the farther it moves away
from the central point the greater distortion in shapes and sizes is introduced as shown in the figure on
below. The process of calibrating such a distortion, as shown in the figure on right, is known as correction.

1. As the laser marks the area that measures the same or larger than the maximum size (110x110 mm),
prepare the material that measures at least 120x120 mm in size.
2. Click [Correction] on the Product Setting.

3. The following screen provides the brief explanation on the calibration process. Click the “Next” button to
start calibration.
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4. Enter the height of the material and click the “Apply” button. Then Click the “Mark” button to start
marking

5. Click the “Next” button to move on to the next step. Measure all sides marked with arrows as shown in the
figure below. If there is any side that measures less than 110 mm, enter the smallest value, and click the
“Mark” button. If all sides measure 110 mm or more, this step can be skipped.

6. This step is to measure the size of all sides and enter measured values to complete the calibration
process. Measure the size as shown in the figure below.
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Make sure that the size is measured from each corner as shown in the figures below.

7. Enter the sizes and click the “Complete” button to finish the calibration process.
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